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CHAPTER 3: MCEGOLD
INTRODUCTION
MCEGold ® is the software that controls the motor tester. This chapter covers the
operation of MCEGold Version 3.0 and the MCEMAX® tester. MCEMAX powered by
MCEGold has several versions, therefore, your tester may not have some of the functions
described in this chapter. If you are using MCEGold Lite it is described in detail on page
3-78.
NOTE: In this manual the full version of MCEGold is referred to as MCEGold.
MCEGold Lite, which is a simplified interface designed principally to collect data, is
referred to as Lite. See page 3-78 for detailed information about Lite.
The software uses standard Window conventions. For example, there is a menu bar, a
toolbar with icons, the red button with an X in the upper right corner closes the window or
exits the program, etc. It is possible to have multiple windows open at the same time.

STARTING MCEGOLD
The program executable is located at:
C:\PdMA Corporation\MCEGold\UI\MCEGold.exe.
1.

To start MCEGold, Select Start from the task bar, then All Programs, PdMA
Corporation, MCEGold or click on the desktop icon

2.

.

At the Login shown in Figure 3-1, select the Site and the Testing Mode if applicable,
Verify the display mode as MCEGold and click OK. Selecting a Site will be
necessary if the database has been detached during a previous session or you want to
change databases.

Figure 3-1: Login
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MCEGOLD HOME WINDOW
The Home window shown in Figure 3-2 opens displaying the Site Navigator, Site
Condition, WatchList, and Message Center windows. The Home window uses standard
Window conventions and multiple windows may be open at the same time.

Figure 3-2: Home Screen

Title Bar
The title bar is the horizontal blue line across the top of the window. It displays the PdMA
logo, the name of the program, and the testing mode.

Menu
The menu area is directly below the Title Bar. If you are using MCEGold Lite it is
discussed on page 3-78.
File - Close, closes MCEGold.
Options - Time Zone, changes the default System Time Zone and the default Date/Time to
user defined values.
To change the Time Zone:
1.

3-2

Select Options, Time Zone.
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2.

MCEGold

Select the Time Zone tab in the Regional Settings window shown in Figure 3 - 3.

Figure 3-3: Regional Settings
3.

Choose the desired time zone from the drop-down list. To access the drop-down
list, click on the down arrow to the right of the box.

4.

Click Apply to apply the change and leave the Regional Settings window open or
click OK to apply the change and close the Regional Settings window.

To change the Date and Time format:
1.

Select Options, Time Zone.

2.

Select the Date/Time tab in the Regional Settings window shown in Figure 3-4.

Figure 3-4: Regional Settings Window
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3.

Select the User Defined option button, which is the default.

4.

Choose the desired date format from the Date Format drop-down list. To access
the drop-down list, click on the down arrow on the right of the box.

5.

Choose the desired time format from the Time Format drop-down list. To access
the drop-down list, click on the down arrow on the right of the box.

6.

Click Apply to apply the change and leave the Regional Settings window open or
click OK to apply the change and close the Regional Settings window.

Options - Preferences opens the Asset Management Preferences window shown in
Figure 3-5. This window allows you to set a search limit (Search Results tab), change the
default save location and control detaching the stand alone database when closing
MCEGold (General tab). If you have a Workstation license and the computer is set up as a
workstation, the default site, search by options, and on-screen keyboard functions can be
selected using the Workstation Settings tab.
Search Results tab allows you to set a limit on how many results are returned when using
the search function. Placing a check in the Limit Search Results check box activates the
drop down list. Select from 10, 25, 50, 100, or 200. After making your selection click
Save or if you do not wish to make a change click Close to close the window.

Figure 3-5: Asset Management Preferences Window
Workstation Settings tab (not available for all users) shown in Figure 3 - 6, controls how
the workstation conducts a search. Select the default site from the drop-down menu. Use
the radio buttons to define which search options, Asset Name, User Asset ID, or Both you
wish to use. If you want an exact match to the search criteria then check the appropriate
check box, if not leave it unchecked. If you want to have an on screen keyboard available

3-4
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check the appropriate check box, if not leave it unchecked. After making your selection/s
click Save or if you do not wish to make a change click Close to close the window.

Figure 3-6: Asset Management Preferences - Workstation Settings
The General tab shown in Figure 3 - 7 controls the disposition of the database when
MCEGold is closing. The Default Save Location is the location the database is currently
saved in. You may change the location by using the browse button to select a new location.
NOTE: You must remember the location, so that you will know where to look for the
database in the future. This is especially true if you are going to detach the database.
To select an option for handling the database when MCEGold closes, click the radio
button in front of the option you wish to select. The default option is “Prompt to detach the
database.” This causes a detach database message to appear when you are closing
MCEGold. “Always detach the local database when closing MCEGold” will
automatically detach the database without a notification. “Never detach the local database
when closing MCEGold” does not detach the database or give you the option on closing to
detach it. After making your selection/s click Save or if you do not wish to make a change
click Close to close the window.

Figure 3-7: Asset Management Preferences - General
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Asset Manger - Use Asset Manager to setup the assets (motors) and folders that are
displayed in Site Navigator. Under the Asset Manager the functions are Manage
Templates, Manage Models (active only with certain licenses), Warning Settings, Asset,
Folder, and Consolidated View. Some of the functions may not appear until a folder or
asset is selected.
Manage Templates allows you to develop templates for kinds types of assets. By
assigning a unique template to an asset, the test results, alarm, and caution values are
more meaningful. To open the Manage User Templates window shown in Figure 3-8
select Asset Manger, Manage Templates from the menu.

Figure 3-8: Manage User Templates
The Manage User Templates window consists of menu items (Add, Copy, Refresh,
and Remove) across the top, a list of templates by asset type on the left side, and the
right side is devoted to Alert Alarms, Fault Zone Text, Measurement Locations, and
Assets tabs. The options below these tabs changes depending on the tab chosen.
To Add a new template:

3-6

1.

Click Add in the Manage User Templates window. Add is located at the top of
the window under the window name.

2.

Select the asset type from the drop-down list in the Add Template window shown
in Figure 3-9. To access the drop-down list, click on the down arrow on the right
of the box.

© 2016 PdMA Corporation

REV. 1-05/20

PdMA MCEGold PRODUCT SUPPORT MANUAL

MCEGold

Figure 3-9: Add Template
3.

Type the template name in the Template Name textbox. Created By and Date
Created are automatically filled in by the software.

4.

Click Apply to add the template and leave the window open or click OK to add
the template and close the window. The template is added in the templates folder
for the asset type chosen. To exit without creating a new template, click Cancel.

To Copy an existing template:
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1.

Highlight the template you wish to copy in the Templates section.

1.

Click Copy. Copy is located at the top of the window under the window name.

2.

Enter the new template name in the Template Name text box of the Copy
Template window shown in Figure 3-10. Created By and Date Created are
automatically added by the software.
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Figure 3-10: Copy Template Window
3.

Click Apply to add the new template and leave the Copy Template window open
or Click OK to add the new template and close the window. The new template is
added to the same folder as the original template. To exit without creating a new
template, click Cancel.

To Refresh the window:
1.

Click Refresh to update the window after changes have been made. Refresh is
located at the top of the window under the window name.

To Remove a template:
1.

Highlight the desired template name in the Templates list.

1.

Click Remove. Remove is located at the top of the window under the window
name.

2.

You will be asked to verify that you want to remove the template, click Yes.

3.

Click OK, when informed the template is removed.

To change the template name:
1.

3-8

Highlight the desired template name in the Templates list.
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2.
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Type the new name in the Template Name text box located in the upper right side
of the Manage User Templates window shown in Figure 3-11.

Figure 3-11: Manage User Templates
3.

Click Apply in the lower right corner of the window to save the change and keep
the Manage User Templates window open or click OK to save the change and
close the Manage User Templates window. To exit without changing the name,
click Cancel.

To change the alert alarms on a template:
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1.

Select the template name in the Templates section of the Manage User Templates
window.

2.

Select the Alert Alarms tab and either the MCE or EMAX tab. The tab you select
drives the alert alarm values displayed in the window shown in Figure 3-12.
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Figure 3-12: Manage User Templates Window
3.

Highlight the desired test from the list in the Alert Alarms section.

4.

Change the Warning Level and Change from Baseline values in the alert alarm
sections located at the bottom of the window.

5.

Click Apply to save the changed the values and leave the window open or click
OK to save the changed the values and close the window. To exit without
changing the values, click Cancel.

The Fault Zone Text tab causes the display to list the six fault zones and a description
of the selected fault zone. Highlight the desired fault zone to read a description of that
fault zone and the recommended actions for assets in caution or severe condition.
The Measurement Locations tab displays the measurements appropriate for the
selected asset template highlighted in the Templates section. To read a description,
select a measurement from the list. The description appears in the Measurement
Location Description section.
The Assets tab displays a list of the assets that have been assigned the template that is
highlighted in the Templates section.
Manage Models - Manage Models is active for a few limited versions. Instructions
are provided individually to users with the active Manage Models function.
Warning Settings
Assign to: Asset - Highlight an asset on the Site Navigator. Select Asset Manager
from the menu, then Warning Setting, Assign to, Asset. The asset values are returned
to the caution and alarm default settings. The asset values shown are assigned to the
selected asset.

3-10
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Assign to: Global - Highlight an asset on the Site Navigator. Select Asset Manager
from the menu, then Warning Setting, Assign to, Global. The Assign Template
Warning Settings window shown in Figure 3-13 opens. The templates listed in the
Select a Template drop down list reflect the asset type of the highlighted asset. Select
a template and click Assign. The template and its values are assigned to that asset and
the window remains open. Click OK the template and its values are assigned to that
asset the window closes. To close the window without assigning a template click
Cancel.

Figure 3-13: Assign Template Warning Settings Window
View Asset Warnings - Changes made to the warning settings here apply only to the
selected asset. Highlight an asset on the Site Navigator. Select Asset Manager from
the menu, then Warning Settings, View Asset Warnings. This opens the Warning
Settings window shown in Figure 3 - 14, for the selected asset. To reset the values to
the default values click Reset To Default. To adjust other values, make the desired
changes in the text boxes making sure you adjust the values for both the MCE and
EMAX tabs if appropriate. Click Apply to save the changes and keep the window
open or OK to save the changes and close the window. To exit without changing the
warning settings, click Cancel.
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Figure 3-14: Warning Settings Window
Asset
Using the Asset Manager, Asset menu allows you to Add, Add Asset From Model
(not available for all users), Copy, Move, Delete, and Edit assets.
Add Asset

3-12

1.

Highlight or create the folder in the Site Navigator (see Asset Manager, Add
Folder) where you want to add the asset.

2.

Select Asset Manager, Asset, Add Asset from the menu.
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3.

MCEGold

In the Add Asset window shown in Figure 3-15, use the drop-down menu to
select an asset class. Currently the choice is either generator or motor. When the
asset class is selected the Select An Asset Type drop-down menu becomes active
as shown in Figure 3 - 16. The choices are dependent on the asset class
selected.Select an asset type.

Figure 3-15: Add Asset - Select An Asset Class

Figure 3-16: Add Asset - Select An Asset Type
4.

REV. 1-05/20

The remainder of the Add Asset window becomes active displaying the
appropriate text boxes for the asset class and type selected shown in Figure 3-17.
The required fields are highlighted in red. The Identification tab is the default
active tab. Fill in the Asset Name
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Figure 3-17: Add Asset
5.

The location is automatically entered based on the folder originally highlighted.
on the Site Navigator. If a different location is desired, select the “Click to change
destination location” option button and highlight the new location on the Site
Navigator. The new location will be entered in the Location text box.

6.

Enter a User Asset ID, if desired. The User Asset ID can be any combination of
alpha and numeric.

7.

Assign a criticality code to the asset, if desired. The code is limited to four
characters in any combination of alpha and numeric. The criticality code is used
in several places in the MCEGold software, most notably the WatchList.

8.

Select each tab, Identification, Manufacturer, Nameplate 1, Nameplate 2, and
Bearing to verify that all required fields are filled in. Changes to the values may
be made at this time. For more information on the nameplate see page 3-33.

9.

Click OK, when all tabs and required fields have been completed. The asset will
be added to the folder.

Add Asset From Model is not available to all users and will not be active.
Copy Asset
1.

3-14

Highlight the asset on the Site Navigator that you wish to copy.
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2.

MCEGold

Select Asset Manager, Asset, Copy Asset from the menu. The Add Asset window
shown in Figure 3-18 opens. Some of the text boxes are filled in based on the
asset being copied. The Asset Name text box is blank and must be filled in.

Figure 3-18: Add Asset Using Copy Asset
3.

To change the location of the new asset select the “Click to change destination
location” option button and highlight the new location on the Site Navigator. The
new location will be entered in the Location text box.

4.

Select each tab, Identification, Manufacturer, Nameplate 1, Nameplate 2, and
Bearing to verify that all required fields are filled in. Changes to the values may
be made at this time.

5.

Click OK to add the new asset.

Move Asset
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1.

Highlight the asset on the Site Navigator that you wish to move.

2.

Select Asset Manager, Asset, Move Asset from the menu. The Move Asset
window shown in Figure 3-19 appears. Note: The Asset Name corresponds to the
asset highlighted on Site Navigator and the Current Location corresponds to the
folder highlighted on the Site Navigator.
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Figure 3-19: Move Asset
3.

To select the New Location, click on the folder on Site Navigator and the new
location will be entered in the New Location text box. The selection must be
made by highlighting the new folder location on the Site Navigator. You cannot
type in the text box.

4.

Click OK to move the asset to its new location.

Delete Asset
1.

To delete an asset, highlight the asset on Site Navigator.

2.

Select Asset Manager, Asset, Delete Asset from the menu.

3.

The Delete Asset window opens with the selected asset name in the Delete text
box and the folder name in the From text box.

4.

Verify it is the correct asset. Click OK.

5.

Click Yes in response to, “Do you want to delete this asset?”

Edit Asset

3-16

1.

To edit an asset, highlight the asset on the Site Navigator.

2.

Select Asset Manager, Asset, Edit Asset from the menu.

3.

The Nameplate window shown in Figure 3-20 opens.
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Figure 3-20: Nameplate Window Using Edit Asset
4.

Asset Type and Location cannot be edited. All other text boxes can be edited.
Change desired information by selecting the tab and entering the new
information in the appropriate textbox.

5.

Click Apply to make the changes and keep the Nameplate window open. The
Nameplate window will remain open and a confirmation box appears. When
informed the Nameplate information has been updated, click OK.

6.

Click OK to make the changes and close the Nameplate window. The Nameplate
window will close after a confirmation box appears.When informed the
Nameplate information has been updated, click OK.

Folder
Using the Asset Manager, Folder menu allows you to Add, Move, Delete, and Edit the
folders.
Add Folder
1.

REV. 1-05/20

Select Asset Manager, Folder, Add Folder. The Add Folder window shown in
Figure 3-21 opens.

© 2016 PdMA Corporation

3-17

MCEGold

PdMA MCEGold PRODUCT SUPPORT MANUAL

Figure 3-21: Add Folder
2.

Enter the folder name.

3.

Verify the Location is the correct location. If an existing folder on the Site
Navigator window is not highlighted then the Add Folder window shows the site
name as the Location. If a folder is highlighted then the Add Folder window
shows the name of the highlighted folder as the Location.

4.

To change the location of the folder, select the “Click to change destination
location” option. Click OK in the Location Change window then highlight a new
site or folder on the Site Navigator window. The location will be entered in the
Location text box.
Note: If you have multiple sites, you can display the site icons and names by
selecting View, Sites from the Site Navigator menu.

5.

Click OK to add the new folder and close the Add Folder window or click Apply
to add the new folder and keep the Add Folder window open to add additional
folders.

Move Folder

3-18

1.

To move an existing folder to a new location, highlight the folder on Site
Navigator. Select Asset Manager, Folder, Move Folder.

2.

The Move Folder window shown in Figure 3-22 opens. The folder name and
current location are automatically displayed.
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Figure 3-22: Move Folder
3.

Highlight the new location on the Site Navigator window. The new location
name will display in the Move Folder window.

4.

Click OK, the folder is moved.

5.

Click OK when informed “Folder moved successfully.” Both windows will
close.

Delete Folder
1.

Highlight the folder to be deleted on the Site Navigator window.

2.

Select Asset Manager, Folder, Delete Folder.

3.

The Delete Folder window opens.

4.

Verify the correct folder name is displayed in the Delete text box and the correct
location of the folder in the From text box is displayed. If not, click Cancel and
begin the process again. You cannot make changes in the Delete Folder window.

5.

If they are correct, click OK.

6.

Click Yes to “Do you want to delete this folder?” The folder is deleted and the
window is closed.

Edit Folder
Edit Folder is used to change the name of the folder.

REV. 1-05/20

1.

Highlight the folder on the Site Navigator window.

2.

Select Asset Manager, Folder, Edit Folder.

3.

The Edit Folder window opens.

4.

Enter the new name in the Name text box.

5.

Click Apply to make the change and leave the window open or click OK to make
the change and close the window. The change is updated on the Site Navigator.
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6.

Click OK when informed the folder information has been updated.

Consolidated View - Selecting Asset Manager, Consolidated View opens the Asset
Assignment Summary List shown in Figure 3 - 23. The assets that are highlighted on
the Site Navigator are listed by Name and the list includes their Template Name,
Warning Assignment, Warning Status, and Asset Type. You may add or delete from
the list and Update the selection to reflect changes in the asset’s status.

Figure 3-23: Asset Assignment Summary List Window
1.

Highlight one or more assets on the Site Navigator.

2.

Select Asset Manager, Consolidate View.

3.

The Asset Assignment Summary List window opens displaying the asset/s
selected.

4.

To sort entries in any column use the diamond shaped icon

to the right of the

column title. The Asset Name column sorts alphabetically the first time, second
click reverse sorts the column. Subsequently it acts as a toggle. Asset Type sorts
alphabetically and lumps each type of asset together. The second click reverse
sorts. Subsequently it acts as a toggle.
Refresh
If a change is made on the Site Navigator to one or more of the assets listed in the
Asset Assignment Summary List, it is possible to update the asset/s by clicking the
Refresh button.
Add an Asset

3-20

1.

With the Asset Assignment Summary List window open, highlight the desired
asset on the Site Navigator.

2.

Click the green circle with the plus sign.

3.

The asset information appears in the list.

© 2016 PdMA Corporation

REV. 1-05/20

PdMA MCEGold PRODUCT SUPPORT MANUAL

MCEGold

Delete an Asset
1.

With the Asset Assignment Summary List window open, highlight the desired
asset name in the list.

2.

Click the red circle with the “x”.

3.

The asset information disappears from the list.

Update Selection
If a change is made on the Site Navigator to one or more of the assets listed in the
Asset Assignment Summary List, it is possible to update the asset/s by highlighting
the asset/s in the list and click Update Selection.
Message – Messaging Center opens the Message Center window if it is not open. The
Message Center is one of four windows that automatically open when MCEGold is
started. It can also be reached by clicking the Message icon

on the toolbar. In

Message Center you can enter, view, edit, and delete notes for one asset or a list of assets.
For more information see the Message Center section in this chapter on page 3-53.
Data – The Data submenus allow an asset’s data file to be created so that it can be
exported or imported to or from another computer electronically or merge two data files
for the same asset.

Export/Single Asset Export
1.

Highlight on Site Navigator the single asset to be exported.

2.

Select Data, Export, Single Asset Export from the menu.

3.

In the Create Export File window shown in Figure 3-24, select a location to store
your file.

Figure 3-24: Create Export File
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4.

Change the File Name if desired. The file extension is .pdp. Do not change the
extension.

5.

Click Save.

6.

When the file is complete, the Single Asset Export message box informs you it is
complete. Click OK.

7.

The file is now ready to send as an attachment or be imported by another
MCEGold tester.
NOTE: Data exported from MCEGold 3.0 cannot be imported into older
MCEGold versions.

Export/Fault Zones
The Export Fault Zone function allows the Fault Zone Analysis to be imported into an
XML interfaced program, such as SAP, Maximo, Indus.
1.

Highlight the asset on the Site Navigator.

2.

Select Data, Export, Fault Zones from the menu.

3.

In the Create Export File window, select a location to save the Fault Zone file.
See Figure 3-25.

Figure 3-25: Create Export File

3-22

4.

Change file name if desired. The file extension is .xml. Do not change the
extension.

5.

Click Save.

6.

You will be informed the Fault Zone Export is complete. Click OK.
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7.

MCEGold

The .xml file is now ready to use in your management programs.
NOTE: There are two files created XSD and XML. The XSD file is a
schema template that the xml file exports.

Import/Single Asset Import
This function is used to retrieve a data file that has been sent to you electronically.
1.

Highlight the folder you wish to import the asset information into.

2.

Select Data, Import, Single Asset Import.

3.

Locate the file and highlight it using the Open Import File window shown in
Figure 3 - 26. The file will have a .pdp file extension.

Figure 3-26: Open Import File Window
4.

Click Open.

5.

You will be asked to verify the location of the import.

6.

The Single Asset Import window informs you of the progress of the import.

7.

When you are notified the import is complete, click OK.

Data/Single Asset Merge
Single Asset Merge is used to combine two assets into one.
1.

REV. 1-05/20

Highlight the asset the data is being merged into.
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2.

Select Data, Single Asset Merge. The Merge Asset Window shown in Figure 3- 27
opens.

Figure 3-27: Merge Asset Window
3.

Highlight the asset that is being merged from on the Site Navigator. It is not possible
to type the name and type in the text boxes.

4.

When the correct Asset Name and Type are entered, click OK.

5.

A window displays the progress. When complete, click OK.

6.

The second asset (asset merged from) is automatically deleted from the database and
no longer displays on the Site Navigator.

Data/Single Asset Import and Merge
The Single Asset Import and Merge function imports the data from a pdp file and directly
merges it with the selected asset. A new asset will not appear on the Site Navigator, the
data is directly merged into an existing asset.

3-24

1.

Highlight the asset the data is being merged into on the Site Navigator.

2.

Select Data, Single Asset Import and Merge.

3.

The Open Import File window shown in Figure 3-28 opens.

4.

Locate and select the pdp file you are importing the data from and click Open.
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Figure 3-28: Open Import File Window
5.

In the Single Asset Import verify box, verify the asset you are importing test data into
and click Yes.

Figure 3-29: Single Asset Import Verify Box
6.

The Single Asset import window informs you of the progress of the import.

7.

When you are notified the import is complete, click OK.

8.

The data will import and merge by data and time into the selected asset. To view the
merged asset information in the Test History window you may have to select Test,
Show Tests, and All Tests since some tests from the merged asset may have been
taken prior to the baseline test in the original asset.

Data/XML Import
XML Import imports an asset via XML format. All asset Nameplate information is
automatically imported into MCEGold as a new asset.

REV. 1-05/20

1.

Select a folder on the Site Navigator.

2.

Select Data, XML Import. The Open Import File window opens.

3.

Locate and select the xml file to be imported and click Open.
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Figure 3-30: Single Asset Import Verify Box
Data/External Device Import
The External Device Import/ Megger is used to import data collected using an external
device the Megger MIT1020 10kV insulation tester.
1.

Select a folder on the Site Navigator.

2.

Highlight the asset the data is to be imported into.

3.

Select Data, External Device, Import, Megger MIT1020. The Open MIT1020 File
window opens.

4.

Locate and select the MIT1020 file to be imported. The file will have a .cvs file type
extension. Click Open.

Windows
MCEGold 3. 0 uses standard Windows operations.
Cascade Windows causes all of the open windows to display one on top of the other in a
cascading manner with only the title bars for each window showing and a full view of the
top window.
Tile Windows causes all of the open windows to display side by side, so that the full
window is shown. The more windows that are open the smaller they will display so that
they can all be accommodated.
Close All closes all open windows, but does not close MCEGold.
A list of the open windows is below these commands. A check mark in front of the
window name indicates it is the active window. Click on any name on the list to make the
window active.
Help
The Help menu provides access to the Product Support Manual and About information.
Product Manual - Selecting Product Manual opens a window displaying the complete
MCEGold Product Support Manual in PDF. Each chapter is listed separately to assist you
in locating the information you are seeking.
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About - Selecting About from the menu opens the About MCEGold window. The
customer information including version number, installed technology, shipping address,
and technical support information is displayed in this window. This information is useful
if you need to contact PdMA regarding your tester. Click OK to close the About window.

Toolbar
The Toolbar icons are designed to quickly access common MCEGold functions with one
click. This section provides a graphic of the icon and a brief description. Each function is
discussed in depth in its own section.
Site Navigator provides a graphical view of the sites, folders, and assets/motors. Use this
icon to restore the Site Navigator window. See the Site Navigator section on page 3-29 for
more information.
Asset Summary provides Last Test Dates, Asset Condition, and Fault Zone information
for the selected asset. See the Asset Summary section on page 3-32 for more information.
Site Condition automatically displays when MCEGold starts and displays selected
information about all of the assets. The data automatically updates when a different site is
chosen. Use this icon to restore the Site Condition window to the MCEGold Home
window if it has been closed. See the Site Condition section on page 3-32 for more
information.
Nameplate displays the nameplate data for the selected Asset so you can view or modify
the data. Some fields are automatically entered by the tester and cannot be modified. An
area to assign a criticality code to the motor is provided. The code is limited to four
characters, any combination of alpha and numeric. Discussion of the nameplate is found in
the Add Asset section on page 3-14 steps 4 and 5 and page 3-33.
Add Asset maybe used in place of selecting Asset Manager, Asset, Add Asset or right
clicking on a folder in the Site Navigator and selecting Add Asset. See the Add Asset
section on page 3-12 for more information. Note: Throughout MCEGold, the term asset is
used to denote various types of assets and motors.
Warning Settings displays the warning settings for the selected asset. If the asset hasn’t
been assigned a template (using Asset Manager, Warning Setting from the menu) the
default settings are displayed. Changes to the setting can be made here. See the Warning
Settings section on page 3-38 for more information.
Test History displays the MCE and E MAX test data, nameplate information, and
Condition Code for the selected asset. See the Test History section on page 3-39 for more
information.
Test Selection opens the Test Selection window that is used to select individual MCE and
EMAX tests for the selected asset. If an automatic combination of tests are preferred the
MCE Auto or EMAX Auto icons can be chosen from the toolbar. See the Testing section on
page 3-43 for more information.
Search opens the Asset Search window to simple search. For a more detailed search click
the Advance button which opens the Advanced Search window. You may return to the
simple search by clicking the Simple Search button. See the Search section on page 3-44
for more information.
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WatchList automatically displays when MCEGold starts. WatchList allows you to set up
lists of assets. A list may be of assets to watch for criticality purposes or to set up a service
route for a technician. Use this icon to restore the WatchList window to the MCEGold
Home window if it has been closed. See the WatchList section on page 3-47 for more
information.
MTAP opens the MTAP configuration window. You must first select an asset before the
icon is active. The window provides information if the asset is linked to an MTAP or
allows you to manually link the asset to an MTAP.
MCE Auto automatically starts the Standard Test followed by the Polarization Index. At
the end of the tests the results are saved and Fault Zone Report is displayed. Before
selecting the MCE Auto icon, an asset must be highlighted on the Site Navigator. See the
MCE Auto section on page 3-52 for more details.
EMAX Auto automatically starts the Rotor Evaluation, Eccentricity, Power, and Demod
tests. At the completion of the tests, after the test results are saved, the Fault Zone
Analysis window displays. Before selecting the E MAX Auto icon an asset must be
highlighted on the Site Navigator. See the EMAX Auto section on page 3-52 for more
details.
Fault Zones displays the Fault Zone Analysis window for the motor/asset highlighted on
the Site Navigator window. See Fault Zone Analysis section on page 3-52 for more details.
Message restores the Message Center window to the MCEGold Home window if is has
been closed. The Message Center window automatically displays when MCEGold starts.
In the Message Center you can enter messages, view message, and delete messages for
one or a list of assets. See the Message Center section on page 3-53 for more information.
Export File opens the Create Export File window, which is used to create an export file to
send data electronically for the selected asset. See the Export file section on page 3-57 for
more information.
Report opens the Report Selection window. See the Reports section on page 3-58 for
more information.
Scheduler opens the Asset Schedule Configurations window which is used to set up the
selected asset for scheduled testing on a one-time or reoccurring basis. See Appendix B for
more information.
Energy Analysis opens the Energy Cost Analysis window which analyzes operating and
replacement cost for AC Induction Design B motors only. See Appendix C for more
information.

Site Navigator Window
The Site Navigator window opens when MCEGold is started or if it has been closed it can
be opened using the Site Navigator icon

on the toolbar.

The Site Navigator window displays the site(s), folders, and motor/assets using the
Windows tree format. The nameplate information is displayed when an asset is selected.
MCEGold is available in single or multiple site versions. Each site has its own unique
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folders and motor/assets. Figure 3-31 shows the Site Navigator window for a single site
version containing folders and motor/assets.

Figure 3-31: Site Navigator
The site, folders, and assets can be displayed or hidden by selecting View and the
appropriate sub-menu from the Site Navigator menu. A check mark in front of sub-menu
name indicates it is displayed in the window. To hide the information remove the check
mark by clicking on it. The check mark acts as a display/hide toggle.
To locate an asset in the Site Navigator, locate the folder that contains the asset, open the
folder and any subsequent folders, then click on the asset. The asset information appears
in the right section. Beginning from the left of the line, a round icon is color coded to the
condition assigned to the asset. The asset name appears next. Asset type and if criticality
has been assigned to the asset during setup it is displayed. On the far right is the nameplate
information. You may also find an asset using the Search function, which is reached by
clicking on the Search icon on the toolbar and described on page 3-44.
For multi-site version, display the site names using the View menu on the Site Navigator
window and selecting the Sites sub-menu. This places a checkmark in front of Sites and
opens a column to the left of the folder column displaying the site names. Highlight the
desired site and the folders and motor/assets in that site will display in the columns to the
right. To close the site column, select View and click Sites to remove the check mark.
Edit, Select All - When multiple assets are displayed, it is possible to highlight them all at
one time by selecting Edit on the Site Navigator window and then Select All. You can also
use the Select All button
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Right Click
A quick way to work with folders and assets in Site Navigator is to right click on the Site,
Folder, or Asset name. Right click on a site closes open folders and assets lists. Right click
on a folder opens a sub-menu that allows you to Add Asset, Add Asset From Model (if
available), Add, Move, Delete, and Edit folders. Right click on an asset opens the submenu that allows you to Add Asset, Add Asset From Model (if available), Copy, Move,
Delete and Edit the selected asset. Also, you can Show Test History and Show Warning
Settings for the selected asset.
To add a folder to the Site Navigator, right click on the Site icon. The sub-menu shown in
Figure 3-32 opens. The only option available under Site location is Add Folder. Select
Add Folder and proceed as described on page 3-17, Add Folder.

Figure 3-32: Right Click Site Icon
To work with the folders in the Site Navigator, right click the folder you wish to work
with. The sub-menu shown in Figure 3-33 opens. Select the desired function.
Instructions on how to preform these activities are discussed previously in this chapter.
Add an Asset instructions are found on page 3-12, Add Folder is found on page 3-17,
Move Folder is found on page 3-18, Delete Folder and Edit Folder are found on page 3-19.
.

Figure 3-33: Right Click Folder Sub-menu
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To work with the assets in the Site Navigator, right click the asset you wish to work with.
The sub-menu shown in Figure 3-34 opens. Select the desired function.
Instructions on how to perform these activities are discussed previously in this chapter.
Add an Asset instructions are found on page 3-12, Copy Asset is found on page 3-14,
Move Asset is found on page 3-15, Delete and Edit Asset are found on 3-16.
Selecting Show Test History and Show Warning Settings open the respective windows for
the asset. The Test History window is discussed later in this chapter on page 3-39 and the
Warning Settings window is discussed on page 3-38.

Figure 3-34: Right Click Asset Sub-menu

Asset Summary
Selecting the Asset Summary icon

on the toolbar opens the Asset Summary window

shown in Figure 3-35. Note: You must highlight the asset in the Site Navigator before
selecting Asset Summary.
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Figure 3-35: Asset Summary Window
The window displays last test dates for MCE and EMAX tests, asset condition, nameplate
summary and links to the Fault Zone Report. Clicking on any test name opens the Test
History for that test. Click in the nameplate area and the nameplate window opens.
Changes to the nameplate values can be made in the window. Click on any item in the
Fault Zone area to open the Fault Zone Report. The Fault Zone Report is fully discussed in
Chapter 5, MCE on page 5-10, Chapter 6, EMAX Current Analysis, and Chapter 7, EMAX
Power Analysis.

Site Condition
The Site Condition window shown in Figure 3-36 automatically displays when MCEGold
is opened. It displays information about the assets in the site. If you have multiple site
software, the data automatically updates each time a different site is chosen. The window
does not have to be closed and reopened. If the Site Condition window has been closed use
this icon
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to restore the Site Condition window to the MCEGold Home window.
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Figure 3-36: Site Condition Window
The Site Condition window opens with the assets in Severe condition listed. To see a list
of assets in a specific condition code, unassigned, or not tested click on the appropriate
button above the asset list. The assets in the selected condition will be listed below. To
locate a listed asset in Site Navigator, click on its name and it will be highlighted on the
Site Navigator window.
The lists opens in alpha/numeric order. You may change the order of any column by
clicking on the small diamond at the top of the list. Depending on which column you
choose it may sort the list alphabetically or in the case of test date sort numerically. The
diamond changes to an up/down triangle indicating the list has been sorted. The triangle
acts like a toggle.
Select All can be used to create a WatchList or used for a report.
The Fault Zone Analysis button in the lower right hand corner opens the Fault Zone
Analysis window for the asset highlighted in the list. If multiple assets are highlighted it
will display the Fault Zone Analysis window for the first asset on the list.

Nameplate
Nameplate displays the nameplate information that was entered when the asset was added.
You must highlight an asset in Site Navigator before selecting the Nameplate icon
on the toolbar. The nameplate window shown in Figure 3-37 opens. You may make
changes or add to the nameplate information using the nameplate window. The text boxes
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highlighted in red are required fields. Keep in mind the more information you enter on the
nameplate the more useful your test data interpretation will be.

Identification Tab
The Identification tab shown in Figure 3-37 contains text boxes for Asset Type, Asset
Name (required), Location, User Asset ID, Criticality, Circuit, and MTAP ID. The Asset
Type, Location, and MTAP ID are automatically entered by MCEGold and cannot be
changed. For the other text boxes, enter the desired information and click OK to save the
changes and close the window or Apply to save the changes and keep the Nameplate
window open.

Figure 3-37: Nameplate: Identification Tab Contents

Manufacturer Tab
The Manufacturer tab shown in Figure 3-38 contains text boxes for Manufacturer Name,
Model Number, Revision Number, Serial Number, and Asset Received Date. The Asset
Received Date text box has a drop down calendar to assist you in entering the date. There
are no required fields on this tab. Enter the desired information and click OK to save the
changes and close the window or Apply to save the changes and keep the Nameplate
window open.
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Figure 3-38: Nameplate: Manufacturer Tab Contents

Nameplate 1 Tab
The Nameplate 1 tab shown in Figure 3-39 contains text boxes for Nameplate Frequency,
Voltage, Horsepower, Kilowatts, Full Load Amps, Nameplate Speed, Operating Speed,
and Frame Number. All, except Operating Speed, are required fields. Enter the required
information and click OK to save the changes and close the window or Apply to save the
changes and keep the Nameplate window open.
Hint: MCEGold will automatically compute the Kilowatts based on the Horsepower
entered by entering the Horsepower and press the <Enter> key on the keyboard. It works
in reverse too. Enter the Kilowatts and press <Enter> to get the horsepower.

Figure 3-39: Nameplate: Nameplate 1 Tab Contents
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Nameplate 2 Tab
The Nameplate 2 tab shown Figure 3-40 contains text boxes for Insulation Type, Service
Factor, Power Factor, Efficiency, Number of Bars, Number of Slots, Design Type, and
Winding Date. There are no required fields. Enter the desired information and click OK to
save the changes and close the window or Apply to save the changes and keep the
Nameplate window open.

Figure 3-40: Nameplate: Nameplate 2 Tab Contents

Bearing Tab
The Bearing tab Shown in Figure 3-41 has text boxes for Shaft-End Bearing Number,
Shaft-End Bearing Type, Opposite-End Bearing Number, and Opposite-End Bearing
Type. There are no required fields. Shaft-End Bearing Type and Opposite-End Bearing
Type have drop down lists to make your choice from. Enter the desired information and
click OK to save the changes and close the window or Apply to save the changes and
keep the Nameplate window open.

Figure 3-41: Nameplate: Bearing Tab Contents
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Resistor Bank Tab
The Resistor Bank tab shown in Figure 3-42 only appears for Wound Rotor assets. It has
text boxes for (Res. Bank) Type, (Resistor Bank) Kilowatts, Full Load Current, and
Cooling Method. There are no required fields. Enter the desired information and click OK
to save the changes and close the window or Apply to save the changes and keep the
Nameplate window open.

Figure 3-42: Nameplate: Resistor Bank (Wound Rotor Asset)

Brush Assembly Tab
The Brush Assembly tab shown in Figure 3-43 appears for Synchronous and DC assets. It
has text boxes for Brush Grade, Brush Dimensions, Number of Brushes, and Minimum
Brush Length. There are no required fields. Enter the desired information and click OK to
save the changes and close the window or Apply to save the changes and keep the
Nameplate window open.

Figure 3-43: Nameplate: Brush Assembly Tab (Synchronous Asset)
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Armature Tab
The Armature tab shown in Figure 3-44 appears for DC assets only. It has text boxes for
Number of Poles, Commutator Segments and Armature Type. There are no required
fields. Enter the desired information and click OK to save the changes and close the
window or Apply to save the changes and keep the Nameplate window open.

Figure 3-44: Nameplate: Armature Tab (DC Asset)

Add Asset
You can quickly add an asset by selecting the Add Asset icon

from the toolbar.

Adding an asset is discussed on page 3-12.

Warning Settings
Warning Settings enables you to change the warning settings for the asset that has been
highlighted on the Site Navigator. If the asset hasn’t been assigned a template (using the
Asset Manager, Warning Setting from the MCEGold menu) the default settings are
displayed.
1.

Highlight the asset on the Site Navigator.

2.

Select the Warning Settings icon

on the toolbar. The Warning Settings window

shown in Figure 3-45 opens.
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Figure 3-45: Warning Settings Window
3.

Select the Test Type and Asset Section tabs.

4.

Highlight the test results you wish to change the warning setting for.

5.

Make the changes in the Warning Level and Change From Baseline values.

6.

Click Apply to apply the new settings and keep the window open or click OK to
apply the new settings and close the window.

Test History
Highlight an asset in the Site Navigator and select the Test History icon

on the

toolbar. The Test History window for the selected asset opens. The window opens to the
MCE test results, shown in Figure 3-46. To view E MAX tests results, click the EMAX
button. The window will change to show the EMAX test results tabs as seen in Figure 3-47.
To view the various test results select the appropriate tab.
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Figure 3-46: Test History Window-MCE Tests

Figure 3-47: Test History Window-EMAX Tests
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Test History Menu
File
Save As Excel (Ctrl+E). To save the test results as an Excel file, select File from the
menu and Save As Excel or Ctrl+E. The Save Data window opens. Enter the location and
a File name, and click Save.
Print Preview (Ctrl+P). Selecting File, Print Preview shows the selected report on the
computer screen before printing. You can print from this window using the tool bar.
Print (Ctrl+P). Selecting File, Print causes the Print window to open. Select the desired
printer and options and click Print.
Exit (Ctrl+X). Selecting File, Exit or Ctrl+X closes the Test History window.

Edit
Copy. The Copy function works in conjunction with preparing a Detailed Report. See
Detailed Report section on page 3-65.
Create Message (Ctrl+M). To add a note to the asset, select Edit, Create Message from
the Test History window. The Compose Asset Message window opens. Compose Asset
Message is covered in the Message Center Section on page 3-55.

View
Graph. A graph can only be prepared if there are more than one test of the same type on
the asset. Highlight the row or rows containing the measured data to be graphed. Select
View, Graph to display the History Graph. The resulting graph may be saved, print
previewed, printed, or the window closed using the File menu on the History Graph
window.
3D Data Graph. This option is inactive/grayed out for MCE, but active for EMAX. To
view the 3D graph, highlight one or multiple EMAX test(s) and select View 3D Graph from
the menu. To change the perspective of the graph, click on the graph and use the cursor to
rotate/change the view.
Raw Data. To view the raw data, select the test results tab, highlight the test, and select
View, Raw Data from the Test History window menu. Figure 3-48 is a sample of the raw
data window for a eccentricity test. Test History and data interpretation are discussed in
Chapter 5-MCE, Chapter 6-E MAX Current Analysis, and Chapter 7- E MAX Power
Analysis.
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Figure 3-48: Data History Using the Raw Data Menu
Refresh (Ctrl+R). Refresh updates the Test History window with changes that have
been made to the asset.

Test
Show Tests: All Tests. Selecting Test, Show Tests, All tests causes the Test History
window to display all test results for the selected asset.
Show Tests: From Last Baseline. Selecting Test, Show Tests, From Last Baseline
causes the Test History to hide any tests before the last baseline and display all tests
subsequent to the last baseline test.
Set as Baseline. To set a particular test as the baseline, highlight the test, select Test,
Set as Baseline from the Test History window. The word Baseline will appear in the
column below the MTAP ID and just above the test results.
Undo as Baseline. To undo a baseline designation, highlight the test results column,
select Test, Undo a Baseline from the Test History window menu. The word Baseline will
be removed from the test results column and alarm conditions from subsequent test results
dependent on the baseline will be removed.
Delete. To remove test results for a particular test, highlight the test results column, select
Test, Delete from the Test History window menu. Click OK when informed the selected
test has been deleted. Note: When test results are deleted it is permanent and they are
irretrievable.

Warning Settings
Warning settings are discussed previously in this chapter in the Asset Manager, Warning
Settings section on pages 3-10 and 3-38.
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Show/Hide
Hide Rows. To hide one row or many rows of test data, highlight the row/s and select
Show/Hide, Hide Rows from the Test History window menu. This is useful when you
have more rows than will display on the computer screen or you just want to see specific
test results.
To select rows that are contiguous, highlight the first row, then press and hold the shift key
on the keyboard, click on the last row you want to be included, release the shift key. All
rows between will be highlighted. Then select Show/Hide, Hide Rows from the Test
History window menu.
To select rows that are not contiguous highlight the first row, then press and hold the Ctrl
key on the keyboard and click the next row to be highlighted. Continue until all rows you
wish to hide are highlighted. Release the Ctrl key. All rows will be highlighted. Then
select Show/Hide, Hide Rows from the Test History window.
Hide Columns. To hide one column or many columns of test data, highlight the column/
s and select Show/Hide, Hide Columns from the Test History window menu. This is useful
when you have more columns than will display on the computer screen or you just want to
see specific test results.
To select columns that are contiguous, highlight the first column, then press and hold the
shift key on the keyboard, click on the last column you want to be included, release the
shift key. All columns between will be highlighted. Then select Show/Hide, Hide
Columns from the Test History window menu.
To select columns that are not contiguous highlight the first column, then press and hold
the Ctrl key on the keyboard and click the next column to be highlighted. Continue until
all columns you wish to hide are highlighted. Release the Ctrl key. All columns will be
highlighted. Then select Show/Hide, Hide Columns from the Test History window.
Show All Rows. To show rows that have been previously hidden select Show/Hide,
Show All Rows from the Test History window menu.
Show All Columns. To show columns that have been previously hidden select Show/
Hide, Show All Columns from the Test History window menu.

Options
Change Test Location. To change the test location of an asset, select Options, Change
Test Location from the Test History window menu. The Change Test Location window
opens. Select the desired test location from the drop down box and click Save.

Test Selection
Test Selection is used to perform individual tests. If an automatic combination of tests is
preferred the MCE Auto or EMAX Auto icons should be chosen from the toolbar. See
MCE Auto or EMAX Auto on page 3-52. Highlight an asset on the Site Navigator and
select Test Selection icon

on the toolbar. The Test Selection window shown in

Figure 3-49 opens. Select the MCE or Emax tab and highlight the desired test. Verify the
testing values are correct and click Test. Using the Test Selection window and testing is
discussed in more detail in Chapter 5, MCE Testing, Chapter 6, EMAX Current Analysis,
and Chapter 7, EMAX Power Analysis.
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Figure 3-49: Test Selection Window

Search
The Search function enables you to locate a specific asset in the Site Navigator. Selecting
the Search icon

from the toolbar opens the Asset Search window shown in Figure 3-

50. There are two types of search, simple or advanced search.

Simple Search
If you know the name of the asset or folder, select the Asset/Segment Name option button
and enter the name in the search textbox and click Search. The asset/folder will be listed
in the Search window and highlighted on the Site Navigator. You may also search by User
Asset ID, by selecting the User Asset ID option and typing the Asset ID in the textbox and
click Search.

Figure 3-50: Asset Search Window
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Advanced Search
Advanced Search is an extensive program that searches the entire database to locate
specific assets using the nameplate data and/or test results. You can use as many or as few
of the search criteria as needed, but at least one criteria must be selected. Depending upon
the criteria chosen, the results will be displayed as a single asset or a list of assets in a new
window titled Search Results. From the Asset Search window, click the Advanced button.
This opens the Advanced Search window shown in Figure 3 - 51.

Figure 3-51: Advanced Search Window

Search Criteria
Criticality is assigned at the time the asset is setup.
Asset Type is a drop-down list box. You can select from the drop-down list or leave it
blank. Click the down arrow and scroll through the list to select the asset type.
Manufacturer is a drop-down list box displaying the manufacturer list database. Click the
down arrow and scroll through the list to select the manufacturer or type the first letter of
the name and click the down arrow to go to that alphabetical section of the list.
Serial Number, Model Number, and Frame Number are text boxes. Type the motor
identifier in the text box, matching spaces and dashes, but it is not necessary to match
case.
Voltage, Operating Speed, Full Load Amps, Horsepower, and Kilowatts all have
check boxes to indicate values that are less than (<), equal to (=), or greater than (>). You
may select one or two, but not < and > together. If a box is checked, a value must be
entered in the text boxes to the right of the check boxes.
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Asset Section is a drop-down list box displaying the asset sections appropriate for the
asset type chosen. A asset type selection must be made before selecting an asset section. If
an asset type is not chosen, the asset section list will be empty.
Condition Code searches based on asset condition. A check mark in the box indicates the
code is selected. Any combination of boxes is allowed.
Test Type is a drop-down list box displaying all of the test types. When the test type is
selected, the upper right hand section of the window displays additional search criteria
based on the test type. See Test Data information on this page.
Date Section contains three options:
Use date is inactive until selected. Selecting Use Date activates the Tested, Not
Tested and After functions.
Tested will search for assets that have been tested after the date in the After text box.
The date can be manually changed to the desired date by typing it in or using the drop
down calendar.
Not Tested will search for assets that have not been tested after the date in the After
text box. The date can be manually changed to the desired date by typing it in or using
the drop down calendar.
After is the test date criteria chosen. It can be manually changed to the desired date
by typing it in or using the drop down calendar
Test Data area is located in the upper right corner. The area is blank until a test type is
selected, then the appropriate test data criteria are displayed. Figure 3-52 shows how the
area would look if Power is selected as the test type. The check boxes indicate values that
are less than (<), equal to (=), or greater than (>). You may select one or two, but not < and
> together or all three. If a box is checked, a value must be entered in the text boxes to the
right of the check boxes.

Figure 3-52: Advanced Search Window
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Search Buttons
Search
Search searches the entire database using the criteria selected. When completed, a list of
assets matching the search criteria is displayed in a new window titled Search Results,
shown in Figure 3-53. To locate a listed asset on the Site Navigator highlight it. To view
the search criteria, you can use the scroll buttons or click the Show All button, which
opens a new window displaying the search criteria.

Figure 3-53: Advanced Search Results Window

Clear Criteria
Clear Criteria removes all previously entered search criteria, so you may begin a new
search using different criteria.

Simple Search
The Simple Search button returns you to the initial window where you can search by name
or scrolling through the asset list.

WatchList
The WatchList window, shown in Figure 3-54, is one of four windows that open
automatically when MCEGold is started. If it is closed you may re-open it by selecting the
WatchList icon

on the toolbar.

The WatchList can be used for multiple purposes. For example, it can be a list of critical
assets or a work list for the technician or both. The WatchList can have multiple user
developed lists. The window consists of three sections, the upper left section displays the
names of the lists, the lower left section gives the administrative details of the selected list,
and the large section on the right displays the assets and selected details of the selected
WatchList. The asset details are: condition code (represented by a color coded icon),
Criticality, Name, Type, Last EMAX Test Date, Last MCE Test Date, Last Condition
Change.
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Figure 3-54: WatchList

WatchList Menu
File
Refresh. Using the Refresh function updates the WatchList window after changes have
been made.
Save. The save function saves changes that have been made to the WatchList.
Close. The Close function closes the WatchList window.

Edit
Add Watch List (Ctrl+N) . The Add Watch List function creates a new WatchList this
may also be accomplished by clicking the Add button

. See the section titled

Create a WatchList for more information.
Edit Selected WatchList. Edit Selected WatchList opens the WatchList Edit window
which allows you to modify the name, change the shared function, and add or modify the
description. When changes have been made, click OK. The changes will update
automatically on the window, but you must save them (File, Save) before exiting the
WatchList or MCEGold or the changes will be lost.
Copy Selected WatchList. To copy a WatchList select Edit, Copy Selected WatchList
from the WatchList window menu. The WatchList Copy window shown in Figure 3-55
opens.
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Figure 3-55: WatchList Copy Window
You may change the name, shared feature, and description. Then click Create. The new
copied WatchList will automatically appear on the WatchList list.
Delete Selected WatchList. To completely delete a WatchList, select File, Delete
Selected WatchList from the WatchList window menu. This may also be accomplished by
using the Delete button

. See the section titled Delete WatchList for more

information.
Add Selected Item. To add a selected asset to a WatchList, select File, Add Selected
Item from the WatchList window menu. See the section titled Add Asset to WatchList for
more information. This may also be accomplished by clicking the Add button

.

See the section titled Add Asset to WatchList on page 3-50 for more information.
Delete Selected Item. To delete an asset from a WatchList, select File, Remove
Selected Item from the WatchList window menu. See the section titled Delete Asset from
WatchList on page 3-50 for more information.
Select All Items (Ctrl+A). To highlight all of the assets in a selected WatchList,
highlight the WatchList name, select File, Select All Items from the WatchList window
menu. All of the assets in the asset list will be highlighted.

Create a WatchList

REV. 1-05/20

1.

If the WatchList window is not open, click the WatchList icon on the MCEGold
Home window toolbar.

2.

In the WatchList window (upper left section), click
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3.

In the WatchList Create window shown in Figure 3-56, fill in the list name, check the
Shared box if you wish others to be able to make changes to this list, and enter a
description. All other information is automatically entered for you. Click Create.

Figure 3-56: WatchList Create
4.

The list name will appear on the layout in the upper left section displaying WatchList
names. The name will be preceded by an icon

representing a WatchList. The

lower left section gives the administrative details of the list.
5.

The asset list on the right side is blank. You are now ready to add assets to the new
WatchList.

Add Asset to WatchList
1.

Highlight a WatchList from the list of name on the WatchList window.

2.

Highlight a single or multiple assets on the Site Navigator window. You may also
select assets from a list generated by the Site Condition window.

3.

Click

on the asset section of the WatchList window. The asset’s

information is added to the WatchList.
4.

Click Save
WatchList.

on the asset section of the WatchList to save the additions to the

Delete WatchList
1.

Highlight a WatchList in the WatchList section (upper left).

2.

Click the Delete button,

3.

The Confirm Delete window opens. Verify the correct WatchList is being deleted and
click Yes. The list will be removed immediately.

, found in the upper left section.

Delete Asset From WatchList
1.

Highlight an asset on the asset section (right side) of the WatchList window.

2.

Click the Delete button,

, found in asset section on the right side of the

WatchList window. This deletes the highlighted asset from the WatchList.
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3.

Click Save

MCEGold

to save the changes made to the asset list.

Asset List Section
Selected information is displayed for the assets in a WatchList. This information is:
Condition Code (represented by a color coded icon) Criticality, Name, Type, Last EMAX
Test Date, Last MCE Test Date, Last Condition Change.
Re-ordering the List. When a WatchList is created there is an order number associated
with each asset in the list. The order number is located in the first column of the list. It is
possible to change the order the assets appear on the list. The original order number is
displayed to the right of the Delete button and does not change when the asset is moved to
a different place in the list.
To move the asset to another location on the list, highlight the asset to be moved, enter the
desired order number in the text box located just above the list, and click the Change
button

.

To move an asset up or down one line at a time, highlight the asset to be moved, and use
the Up button

or Down button

.

See Figure 3-57 for the order number before re-ordering the list. Figure 3-58 shows the
order number after re-ordering.

Figure 3-57: Asset List Order Number Before Re-order

Figure 3-58: Asset Order Number After Re-order
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MCE Auto
MCE Auto performs a Standard test followed by a Polarization Index Test, then saves the
test data and produces a Fault Zone Report. Selecting the MCE Auto icon

by-

passes the Test Selection window and starts the Standard test using the previously saved
test setup settings.
Note: If you need to change the test setup settings, select the Test Selection icon, the
Test Selection window opens, make your changes, and select MCE Auto on the Test
Selection window.

MCE Auto Test
1.

Highlight an asset on the Site Navigator.

2.

Click the MCE Auto icon

3.

The testing begins automatically and ends with the display of the Fault Zone Report.

on the toolbar.

There is a full discussion of the MCE Auto test and its windows in Chapter 5, MCE.

EMAX Auto
EMAX Auto automatically starts the Rotor Evaluation tests, followed by the Eccentricity,
Power, and Demod tests. At the completion of the tests, the test results are saved, and the
Fault Zone Report is displayed.
Selecting the EMAX Auto icon

by-passes the Test Selection window and starts

the Rotor Evaluation test using the previously saved test setup settings.
Note: If you need to change the test setup settings, select the Test Selection icon, the
Test Selection window opens, make your changes, and select EMAX Auto on the Test
Selection window.

EMAX Auto Test
1.

Highlight an asset on the Site Navigator.

2.

Click the EMAX Auto icon

3.

The testing begins automatically and ends with the display of the Fault Zone Report.

on the toolbar.

Fault Zones
Selecting the Fault Zone icon

from the toolbar opens the Fault Zone Report for the

selected Asset. You must have an asset highlighted on the Site Navigator. See Figure 3-59.
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Figure 3-59: Fault Zone Report Window
The Fault Zone window contains an optical presentation of the six fault Zones in the
center and areas on the right hand side for the Condition Code button, View Raw Data
button, View Test History button, the date of the last EMAX test, Date of the last MCE test,
and a description of the item highlighted on the optical chart.
Condition Code. Click on the Condition Code button to open the Condition Code
Update window. From this window you can change the condition code by clicking on the
code choices on the left. The selected code will appear in the Selected Condition Code
box. Click Update Condition to change the code and exit the window or Cancel to exit the
window without making any changes.
View Raw Data. Click on the View Raw Data button to open the Data History window.
View Test History. Click on the View Test History to open the Test History window.
Last Emax Test. Click on the Last EMAX Test button to open the Test History window
displaying the EMAX test results.
Last MCE Test. Click on the Last MCE Test button to open the Test History window
displaying the MCE test results.
Description. The Description area changes as values on the optical chart are highlighted.
No changes can be made to the descriptions.

Message Center
The Message Center window, shown in Figure 3-60, is one of four windows that open
automatically when MCEGold starts. It is located across the lower part of the MCEGold
Home window. When it opens initially the right hand pane is blank. If the Message Center
has been closed, it can be re-opened by selecting the Message icon
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In Message Center you can enter, view, edit, and delete notes for one asset or a list of
assets.
Notes are automatically generated when a condition is assigned or changed or when the
warning levels are changed. Other notes are entered by the user.
If an asset has notes associated with it, they will be automatically listed whenever the asset
name is highlighted on Site Navigator.

Figure 3-60: Message Center

Message Center Menu
File
Compose Message. An asset must be highlighted on the Site Navigator to compose a
note in the Message Center. Select File, Compose Message from the Message Center
window menu. The Compose Message window opens. The window and a discussion are
shown on page 3-55.
Close. Selecting File, Close from the Message center window menu closes the Message
Center. You can re-open it by clicking the Message icon on the MCEGold Home window
toolbar.

Edit
The Edit menu displays only Delete Message unless the Trash icon is selected. If the Trash
icon is selected, a list of deleted notes waiting for disposal appears and the Edit menu
displays the Restore Message and Delete Message sub-menu functions. See Trash on page
3-57 for information on deleting or restoring messages from the trash.
Delete Message. To delete a message highlight the message in the Message Center
window and select Edit, Delete Message from the Message Center menu. You will be
asked to confirm you wish to send the message to the trash can. Click Yes.The message
will be deleted and held in the Trash.
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View
Active Asset Only. Active Asset Only causes the Message Center to provide
information only for the asset highlighted on the Site Navigator when Asset diagnostics is
selected. If it is unchecked a list of all assets in the database with notes will be generated
when Asset Diagnostics is selected. The check mark acts as a toggle to view either active/
selected asset or all assets with notes.

Option
The Option function allows you to see messages created in a specific period of time, last
30, 60 or 120 days, or all dates. A check mark indicates the selection.

View Notes
1.

Select Message icon

on the toolbar, if the Message Center window is not open.

2.

Verify that Active Asset Only on the View menu of Message Center window is in the
checked or unchecked position (which ever is desired).

3.

Select the note date range from the Option menu of the Message Center window.

4.

Click the Asset Diagnostic icon

. A list of assets will be compiled depending on

the status of the Active Asset Only and date range selections from the menu.
Note: Unless you have Active Asset Only checked in the View menu, when Asset
Diagnostic is clicked it will display a list of all the assets in the Site Navigator that
have notes. If Asset Only is checked, then only the asset highlighted on Site
Navigator is displayed.
5.

REV. 1-05/20

To view the notes associated with an asset, highlight the line for the asset. The notes
are displayed in the section below the list.
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Compose
Using Compose allows you to add a note or attach files to a selected asset’s record.
Compose can be reached by selecting File, Compose Message on the Message Center
menu or clicking the Compose icon

.

Figure 3-61: Compose Asset Message

Compose Message
1.

Highlight an asset on the Site Navigator or in the WatchList.

2.

Select File, Compose Message from the Message Center window menu or click the
Compose icon

.

3.

The Compose Asset Message window, Figure 3-61, opens.

4.

The User and Asset names are automatically entered by MCEGold.

5.

Enter a subject (required field).

6.

Message Type, Asset Section, and Test text boxes are drop-down lists. They are not
required fields.

7.

Type your message in the blank area at the bottom of the window. A message is
required.

8.

To attach a file or document. click the Attach button.

9.

The Open window opens. Locate the file and highlight it so that the name displays in
the File Name textbox and click Open.

10. The file name is displayed in the Attachments area of the window.
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11. Click the Save button.
12. On the Message Center window, a paperclip to the left of the message line indicates a
file or files are attached to the note.

View Attachment
1.

Highlight the line of the message you wish to view.

2.

Select the attached file from the drop-down list in the Attachment File textbox.

3.

Select either the Open it or Save it to Disk option and click OK.

Scheduler
See Appendix B for a complete discussion of the scheduler function.

Asset Diagnostic
Click the Asset Diagnostic icon

in the left panel to display the desired asset or a list

of all assets. Unless you have Active Asset Only checked in the View menu, when Asset
Diagnostic is clicked it will display a list of all the assets in the Site Navigator. If Asset
Only is checked, then only the notes for the asset highlighted in Site Navigator is
displayed.

Asset Condition
A note is automatically generated by MCEGold when the condition code of an asset is
changed. To view a list of the assets that have had a condition code change, click the Asset
Condition icon

, then highlight the asset from the displayed list to view the associated

notes.

Asset Warning Levels
A note is automatically generated by MCEGold when the warning levels of an asset are
changed.To view a list of the assets that have had changes to their warning levels, click the
Asset Warning Levels icon

, then highlight the asset from the displayed list to view

the associated notes.

Trash
Clicking the Trash icon

displays a list of deleted notes.

Restore Message. You can restore a message to its original location by highlighting the
note and selecting Edit, Restore Message from the Message Center window menu.
Delete Message . To permanently delete a message, select Edit, Delete Message from
the Message Center window menu. This will permanently delete the message. You will be
asked to verify that you wish to continue. Click Yes and the message disappears.
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Note: The Edit menu displays Delete Message when the message is highlighted. If the
Trash icon is clicked, a list of deleted notes appears and the Edit menu contains Restore
Message and Delete Message submenu functions.

Export File
Export File is used to create a file so that it can be sent to another computer electronically.
1.

Highlight a single asset in Site Navigator.

2.

Select the Export icon

3.

In the Create Export File window, Figure 3-62, select a location to store your file.

on the toolbar.

Figure 3-62: Create Export File
4.

Change the File Name if desired. The file extension is .pdp. Do not change the
extension.

5.

Click Save.

6.

Click OK, when the Single Asset Export message box informs you it is
complete.

7.

The file is now ready to send as an attachment or to be imported by another
MCEGold tester.

Report
Report is reached by highlighting an asset on the Site Navigator and selecting the Report
icon

on the toolbar. The Report window shown in Figure 3-63 opens. There are

seven reports available: AC EMAX Summary, Asset Condition Code, Asset Inventory,
MCE Summary, Message History, PI/DA Summary, and Detailed. An additional option is
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Word Report Templates. When a report type is selected its description will display in the
Report Type Description area directly below Report Name. Not all of the options on the
Report Selection window are available for every report. If an option is not available it will
appear dimmed.

Figure 3-63: Report Selection Window

AC EMAX Summary
1.

Highlight one or multiple assets on the Site Navigator.

2.

Select the Report icon

3.

Select AC EMAX Summary from the Report Name list, if not already highlighted.
This is the default selection.

4.

Fill in the Submitted By and Report Description text boxes.

5.

Select the date. The choices will produce a report showing test data for All Dates or a
selected date range depending on which radio button is selected. The default is All
Dates.

from the MCEGold Home window toolbar.

To select a date range, select the Only motors with tests taken between option button.
Then either manually enter the date or use the drop-down calendar to select a date in
the From Date and To Date text boxes.

REV. 1-05/20

6.

Name Selection will be used in future versions.

7.

The All Selected Motors option is automatically selected. For MCE and PI DA
Summary reports Motors in Caution and Alarm Only may be selected.

8.

Include Last Message in not selected by default, click on the check box to select this
option if desired.
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9.

Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-64 shows a completed report.
11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-64: AC EMAX Summary Report - Preview

Asset Condition Code
1.

Highlight one or multiple assets on the Site Navigator

2.

Select the Report icon

3.

Select Asset Condition Code from the Report Name list.

4.

Fill in the Submitted By and Report Description text boxes.

5.

All Dates is the default Date Selection and cannot be changed.

6.

Name Selection will be used in future versions.

7.

All Selected Motors is the default and cannot be changed.

8.

Include Last Message is not selected by default, click on the check box to select this
option if desired.

9.

Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

from the MCEGold Home window toolbar.

10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-65 shows a completed report.
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11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-65: Asset Condition Code Report - Preview

Asset Inventory

REV. 1-05/20

1.

Highlight one or multiple assets on the Site Navigator

2.

Select the Report icon

3.

Select Asset Inventory from the Report Name list.

4.

Fill in the Submitted By and Report Description text boxes.

5.

All Dates is the default Date Selection and cannot be changed.

6.

Name Selection will be used in future versions.

7.

All Selected Motors is the default and cannot be changed.

8.

Include Last Message is not selected by default, click on the check box to select this
option if desired.

9.

Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

from the MCEGold Home window toolbar.
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10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-66 shows a completed report.
11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-66: Asset Inventory Report - Preview

MCE Summary
1.

Highlight one or multiple assets on the Site Navigator

2.

Select the Report icon

3.

Select MCE Summary from the Report Name list.

4.

Fill in the Submitted By and Report Description text boxes.

5.

Select date. The choices are to produce a report showing test data for all dates or
select a date range. The default is All Dates.

from the MCEGold Home window toolbar.

To select a date range, select the Only motors with tests taken between option button.
Then either manually enter the date or use the drop-down calendar to select a date in
the From Date and To Date text boxes.

3-62

6.

Name Selection will be used in future versions.

7.

All Selected Motors option is the default. Select Motors in Caution and Alarm only if
that option is desired.

8.

Include Last Message is not selected by default, click on the check box to select this
option if desired.
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Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-67 shows a completed report.
11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-67: MCE Summary Report - Preview

Message History
1.

Highlight one or multiple assets on the Site Navigator

2.

Select the Report icon

3.

Select Message History from the Report Name list.

4.

Fill in the Submitted By and Report Description text boxes.

5.

Select date. The choices are to produce a report showing messages for all dates or
select a date range. The default is All Dates.

from the MCEGold Home window toolbar.

To select a date range, select the Only motors with tests taken between option button.
Then either enter the date or use the drop-down calendar to select a date in the From
Date and To Date text boxes.
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6.

Name Selection will be used in future versions.

7.

All Selected Motors option is the default and cannot be changed.
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8.

Diagnostic Messages Only is unchecked by default. Check the box to select the
option if desired.

9.

Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-68 shows a completed report.
11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-68: Message History Report - Preview

PI/DA Summary
1.

Highlight one or multiple assets on the Site Navigator

2.

Select the Report icon

3.

Select PI/DA Summary from the Report Name list.

4.

Fill in the Submitted By and Report Description text boxes.

5.

Select date. The choices are to produce a report for all dates or select a date range.
The default is All Dates.

from the MCEGold Home window toolbar.

To select a date range, select the Only motors with tests taken between option button.
Then either enter the date or use the drop-down calendar to select a date in the From
Date and To Date text boxes.
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6.

Name Selection will be used in future versions.

7.

All Selected Motors option is the default. Select Motors in Caution and Alarm only if
that function is desired.

8.

Include Last Message is not selected by default, click on the check box to select this
option if desired.

9.

Show Color is selected by default and causes the condition code color to appear on
the report. Uncheck the box to deselect this option.

10. Click Preview to preview the report on the screen before printing or Print Only to
print the report to your default printer. Figure 3-69 shows a completed report.
11. If there is no data for the asset, a message window opens indicating there is no data
for the selected asset.
12. Close the Report Selection window using the Close button.

Figure 3-69: PI/DA Summary Report - Preview

Detailed Report
The Detailed Report window allows you to create a customized report of one or two pages
for one or multiple assets. It is possible to drag and drop test results that are open on the
desktop into the report, copy and paste test history results, import files, view and/or print
previous saved reports.

Create New Detailed Report - Single Asset
To create a new detailed report versus using a saved template.

REV. 1-05/20

1.

Highlight an asset on Site Navigator.

2.

Select the Report icon

3.

Select Detailed from the Report Name list. The right side of the Report Selection
window changes to display selections for the detailed report. See Figure 3 - 70.

on the MCEGold Home window toolbar.
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Figure 3-70: Detailed Report - Report Selection Window
4.

Select Create New option button (default).

5.

In the Choose New Report Template section, highlight the desired layout.

6.

The Report Type defaults to Single Asset Report. If you are preparing a multiple asset
report see the section titled Multiple Asset Report on page 3-64.

7.

Click Design.

8.

The Report Template window opens in the layout selected in step 5. The selected
asset information is automatically entered. See Figure 3 - 71.

Figure 3-71: Report Template Window
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Multiple Page Option
1.

A second page may be added by clicking on the icon representing the desired layout.
The icons are located to the right of Insert Page and directly below the menu on the
report window. See Figure 3-71.
You can toggle between page one and two by clicking the
tabs at the lower left of the window. See Figure 3-72. There
is a maximum of two pages per report.
To delete a page, select the page tab that you wish to delete
and click Delete Page, which is located directly to the right
of Insert Page and below the menu.

Figure 3-72: Two-page Detailed Report Tabs
2.

The section below the Insert Page area contains the Report Description information
about the report and the asset. It is automatically generated by MCEGold and cannot
be modified.

Page Header
The page header default information is Report Title, Submitted By, Create Date, Asset
Name, and Description. Any of these may be modified using the Edit-Header function
located along the right side of the window. If the Edit Header area is not visible, click
anywhere in the Report Header or Page Header sections.
1.

Click on any of the titles. A box displays around the area to be modified and the EditHeader window opens to the right of the report. See figure 3 - 73.

Figure 3-73: Detailed Report Window - Edit Header
2.

Select the Header Entry from the drop-down list under Select Header Entry. See
Figure 3-74.
Header Entry List selections and their descriptions are:
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Nothing causes a blank area to display in the
header.
User Defined allows you to enter a user
defined title by typing it in the Caption text
box and entering text in the Value box. See
Figure 3-73.
Create Date automatically enters the current
date and time.
Submitted By automatically enters the name
of the person generating the report.
Asset Name automatically enters the name of
the asset.
User Asset ID allows you to enter a user
defined asset ID by typing it in the Value
box.
Report Title allows you to enter a user
defined title by typing it in the Value box.
Asset Location automatically enters the
location of the asset.
Asset Condition automatically enters the
condition of the asset.
Figure 3-74: Detailed Report Window - Select Header Entry
Span Header to full width causes the text box to go across the entire width of the
report header. A check mark indicates the option is selected. Place or remove the
check mark and click Apply Change.
Note: There are four additional text boxes in the header areas. They are located on the
right hand side in the header area to the left of the logo. They do not become apparent
until the cursor is placed there and clicked.
3.

After selecting and entering the header information, click Apply Change to display
the new or modified headers and text.

4.

Repeat steps 1 - 3 until you have completed setting up the page header area.

Logo Area
The logo area can also be modified with a user defined choice.
1.

3-68

Click on the logo and the Select Type window opens.
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2.

Select Edit - Image (located at the bottom of the
window). The Edit - Image pane shown in Figure 375 opens.

3.

To insert an image of your choice, select the From
File option, then click Insert Picture. Browse for
the location of the picture that you wish to insert
into the logo area. Highlight it so that the name
appears in the File name text box. Click Open. The
new image will appear in the logo area.

Figure 3-75: Detailed Report - Edit-Image Window
4.

You may insert data files in the logo area by selecting the From Data option. Make a
selection from the Type drop-down list. The choices and descriptions are:
If you select Nameplate Information, you can insert it into the logo area by clicking
Insert. To view it without inserting it click Open.
If you select Graph, you must then select the Section, Test, Available Selection, and
Date from the drop-down lists before clicking Insert. To view it without inserting it
click Open.
If you select Test History, you must then select the Section and Test from the dropdown lists before clicking Insert. To view it without inserting it click Open.

5.

Reset removes the selections from the drop-down lists and returns you to the From
File option.

6.

Edit - Image Properties allows you to stretch, zoom, or clip the inserted image.

Detail Area
The main area of the Detailed Report is the detail area. It is configured according to the
layout selected.
1.

To add information to the detail area, click the
area to highlight it. The Select-Type section
opens on the right side of the window. Select the
desired option in the Select Type window shown
in Figure 3-76.

Figure 3-76: Detailed Report - Select - Type Window
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Remove Current Selection clears the highlighted area on the report.
Data/Picture (default value) allows you to insert test results or a picture. See step 2 of
the Logo Area section on page 3-68.
Text Box allows you to use the area for comments. Select Text Box and Edit Comment selection bar located across the bottom of the window. A word processing
window opens. Type your comments. They appear in the highlighted area on the
report.
Last Diagnostic Message inserts the last message in the selected area of the Detailed
Report. Select this option and Insert Last Message.
2.

Depending on the type of information inserted into the detail area, some areas may
have asset information and a place for comments at the top of the area. To add or
change information in this area, select Edit - Comment and make the changes. See
Figure 3-77.

Figure 3-77: Detailed Report - Edit Comments Window
3.

When the report is complete you may save it by selecting Save Layout, or Save
Layout As from the File menu. See Detailed Report File Menu information following
this section.

Detailed Report File Menu
When the report is complete use the File menu to save or print.

Save Layout. S e l e c t i n g S a v e L a y o u t
opens the Save Report as Template window.
See Figure 3-78. Enter a name in the Save
As textbox. Click the Set As Default check
box if the layout is to be used as a template
in the future. Enter a description. Click
Save.

Figure 3-78: Save Report as Template Window
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The Detailed Report remains open. Select File, Close to close the window. You are
returned to the Report Selection window, which is displaying the Saved Report Lists.
In the future, when the Saved Report List option is chosen on the Report Selection
window, the template will be listed. See Saved Reports List on this page.
Save Layout As. Selecting Save Layout As opens the Save Report as Template
window. Enter a name in the Save As textbox. Click the Set As Default check box if the
layout is to be used as a template in the future. Enter a description. Click Save.
When the Saved Report List option is chosen on the Report Selection window, the
template will be listed. Select Template (menu) and desired function or right-click the line
and get the same choices. See Saved Reports List on this page.
Page Setup. Selecting the Page Setup function opens the Report Settings window. In
this window you can adjust the looks of the printed page.
Print Preview. Print Preview displays the Detailed Report on your computer screen as it
will appear when printed.
Print Preview File Menu
Export To PDF saves the Detailed Report as a PDF. Select Print Preview, Export to PDF.
In the Save As window select a location and enter the file name. Click Save.
Export To HTML saves the Detailed Report as a HTML file. Select Print Preview, Export
to PDF. In the Save As window select a location and enter the file name. Click Save.
Close causes the Print Preview window to close.
Close. Closes the Detailed Report.

Saved Reports List Option

REV. 1-05/20

1.

Highlight an asset on Site Navigator.

2.

Select the Report icon

3.

Select Detailed from the Report Name list. The right side of the Report Selection
window changes to display selections for the detailed report. See Figure 3 - 79.

on the MCEGold Home window toolbar.
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Figure 3-79: Detailed Report - Report Selection Window
4.

Select the Saved Reports List option. The window displays a list of saved reports.See
Figure 3-80.

Figure 3-80: Detailed Report - Saved Reports List
5.

To work with a detailed report on the list, select Template (menu) and desired
function or right-click the line and get the same choices.
Set as Default causes the selected template to be the default template. The status
changes from No to Yes in the default column and the template moves to the top of
the list.
Using Edit opens the report so that you may make changes or print the report using
the File menu on the Detail Report window.
Selecting Delete causes the report to be deleted. You will be asked to confirm if its
deletion.
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Multiple Asset Detailed Report
If you are creating a report for multiple assets, select the Multi-Asset Report option button
in the Report Type section of the Report Selection window and click Design. This allows
you to import information from more than one asset into the detailed report.
The section below the Insert Page area contains information about the report and the asset.
It cannot be modified. On a multi-asset report the asset information is not displayed and
under the asset name in the page header section it displays Multi-Asset Report.
Continue preparing the report as with a single asset for the layout selection (page 3-65),
header information (page 3-67), and logo area (page 3-68).
Detail Section
1.

Click the desired detail area of the Detailed Report.

2.

Highlight an asset on the Site Navigator or WatchList.

3.

Use the Edit functions located on the right side of the window.
Note: In the highlighted area the asset information displays across the top. Use Edit
Comments to add Notes or make changes.

4.

Repeat steps 1 - 3 until the report is complete.

5.

See the Detailed Report File Menu section (page 3-70) to save and/or print the report.

Alternative Methods of Inserting Asset Information.
Edit Functions. These are covered on page 3-67 (single asset) and this page (multiple
assets)
Drag and Drop. When test results or a graph are open, arrange the windows so that both
are visible. Then click on test/graph, hold the mouse button, and drag the results to the
desired location on the detailed report window.
Copy and Paste. When test data or a graph are open, right click the test/graph and
select copy from the menu. On the report, right click the area of the report to receive the
results and select Paste from the menu.

Word Report Templates
Note: When installing or updating MCEGold, a Word Add-in driver is installed. You may
receive a message informing you that “Windows can’t verify the publisher of this driver
software.” Select “Install this driver software anyway”.
You must have MS Word installed on your computer to use the Word Report Templates
function. The templates allow you to either use templates generated by PdMA (PdMA
Default Templates) or define templates that are more meaningful to you for your reports
(User Defined Templates). The PdMA Default Templates are only available for AC
Induction motors at this time.
The Report Selection window for Word Report Templates is shown in Figure 3-81.
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Figure 3-81: Report Selection Window: Word Report Templates
Template Type - There are two options for a template, User Defined and PdMA Default.
When an option button is selected the names of available templates for that option appear
in the File Name section.
Selecting the User Defined option displays a list of templates created by you in the
Template Selection window.
Selecting the PdMA Default Templates option displays a list of three templates
created by PdMA in the Template Selection window.
Test Date Options - There are two options for the report, Last Test Dates and Select Test
Dates. These are used to collect test report data.
Template Selection - The Template Selection area displays the available file names for the
template selected.

PdMA Default Template
Use these instructions to prepare a report using a PdMA Default Template.
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1.

Highlight one or multiple assets on the Site Navigator.

2.

Select the Report icon

3.

Select Word Report Templates from the Report Name section.

4.

Select the Template Type (PdMA Default Templates) from the Template Type section
on right side of the window shown in Figure 3 - 82.

on the tool bar.
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Figure 3-82: PdMA Default Templates
5.

Select the Test Date Option. There are two options for test dates, Last Test Dates and
Select Test Dates. If Select Test Dates is selected a Date Selector window opens
allowing you to select the dates for the tests in the report.

6.

Select the file name of the desired template from the Template Selection list. The
Template Selection area displays the available file names for the template type
selected.

7.

Click Create Report. When all selections have been made, clicking Create Report
produces a report in Word format.

8.

The Save As window opens. Select a location for the file. You may change the name
of the file or accept the MCEGold generated name. Click Save.

9.

The Report Saved window opens asking if you would like to view the report. Click
Yes to open the report in Word format or No to close the window without viewing the
report.
When the report opens it will be multiple pages in order to display all of the test data.
Most fields are editable by clicking on them. The actual test data is a graphic and
cannot be changed, but it can be deleted and replaced. If no test data is available that
will be indicated in the appropriate spot.

User Defined Templates
Use these instructions to prepare a report using User Defined Templates. You must first
create a template to be used. See the section Creating a User Defined Template on page 376.
1.
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Highlight one or multiple assets on the Site Navigator.
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2.

Select the Report icon

on the tool bar.

3.

Select Word Report Templates from the Report Name section.

4.

Select the Template Type (User Defined Templates) from the Template Type section
on right side of the window.

5.

Select the Test Date Option. There are two options for test dates, Last Test Dates and
Select Test Dates. If Select Test Dates is selected a Date Selector window opens
allowing you to select the dates for the tests in the report.

6.

Select the file name of the desired template from the Template Selection list. The
Template Selection area displays the available file names for the template type
selected.

7.

Click Create Report. When all selections have been made, clicking Create Report
produces a report in Word format.

8.

The Save As window opens. Select a location for the file. You may change the name
of the file or accept the MCEGold generated name. Click Save.

9.

The Report Saved window opens asking if you would like to view the report. Click
Yes to open the report in Word format or No to close the window without viewing the
report.
When the report opens it will be multiple pages in order to display all of the test data.
Most fields are editable by clicking on them. The actual test data is a graphic and
cannot be changed, but it can be deleted and replaced. If no test data is available that
will be indicated in the appropriate spot.

Creating a User Defined Template
1.

Open Word and click the MCEGold tab on the menu bar as shown in Figure 3 - 83.
This displays the tool bar shown in Figure 3-84 that is used in creating MCEGold
templates. This tool bar may be wider than your monitor can display. Look for the
small arrow at the far right indicating more fields are available.

Figure 3-83: Word Add-In
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Figure 3-84: Word MCEGold Tool Bar
2.

Select Motor and Section Type from the drop down lists. Available options in the
Section Type are driven by the Motor Type selected.

3.

Select Tech Type and Test Type. Available options in Test Type are driven by the Tech
type selected.

4.

Select Graph Type and Selections. Available options in Selection are driven by the
Graph Type selected.

5.

After selecting the Motor Type and Test Data selections use the areas on the right
hand side to design your template. Place the cursor in the place on the Word page that
you want to insert a field or image. Use Insert Image to insert the graph placeholder.
Make a selection from the drop down lists and click Insert Field to insert that
placeholder on your Word document.

6.

After your template is complete, use File, Save As, Word Template. Enter a name and
select a location to save. Make a note of the name and location. Click Save.

7.

To use the template, start MCEGold and use the Reports function. See the user
Defined Templates section on page 3-75.

Create Report Button. Create Report is used to produce the report. It is described in
the procedures.
Delete Template Button. Delete Template removes the template that is highlighted in
the Template Selection area and removes it from your hard drive.
Upload Template Button. Upload Template is used to save a report generated using
the User Defined Template function. This option can only be used with User Defined
Templates.

REV. 1-05/20

1.

Highlight the User Defined Templates option button.

2.

Select a template name from the Template Selection area, click Upload Template.

3.

Select the location to save the file.

4.

Type a name in the File Name textbox and click Open.
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EXITING MCEGOLD
MCEGold may be shut down by selecting File, Close from the menu or clicking the close
button (X) in the upper right corner. You will be asked to verify that you want to Close
MCEGold. Click OK.
Detach Local Database. Before MCEGold closes a window giving you the option to
detach the local database opens if you have set that option up in Preferences, Asset
Management. If desired, click Yes to detach the database and close MCEGold. When you
detach the database, the next time you start MCEGold you will need to select a database
before continuing. Click No to close MCEGold and leave the current database attached.

MCEGOLD LITE INTRODUCTION
MCEGold® is the software that controls the motor tester. This section covers the operation
of MCEGold Lite (identified as Lite) and the MCEMAX tester.
NOTE: In this manual the full version of MCEGold is referred to as MCEGold. MCEGold
Lite, which is a simplified interface designed principally to collect data, is referred to as
Lite.
The Lite software uses modified Window conventions. For example, there is not a menu
bar, the toolbar with buttons is located across the bottom of the screen, the red button with
an X in the upper right corner closes the window or exits the program, but there is an
additional Close button in the lower right hand corner of the Home window. Depending on
your screen resolution you may see scroll bars to be used to display more buttons or more
of the window.
Lite is designed to operate in conjunction with a WatchList. A WatchList displays the
assets that are scheduled to be tested making it easier for you to test without searching the
full database for the asset. WatchLists are set up in MCEGold and Lite will not open if
there are no WatchList.

STARTING LITE
The program executable is located at:
C:\PdMA Corporation\MCEGold\UI\MCEGold.exe.
1.

To start Lite, Select Start from the task bar, then All Programs, PdMA Corporation,
MCEGold or click on the desktop icon
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2.

MCEGold

At the Login (Figure 3-85) select the Site. Verify the Testing Mode (if applicable).
Selecting a Site will be necessary if the database has been detached during a previous
session or you want to change databases. Use the Display Mode drop down menu to
select MCEGold Lite, and click OK.

Figure 3-85: MCEGold Login
3.

The Home Screen shown in Figure 3-86 opens.

LITE HOME SCREEN
The buttons are not active until an asset has been selected. The Home screen has no menu
items. Due to its simplicity, the functions are activated using buttons which are located
across the bottom of the screen. The Scroll bar indicates more buttons are available. In our
example Scheduler is not shown until you scroll down.
.

Figure 3-86: Lite Home Screen
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Title Bar
The title bar is the horizontal blue line across the top of the window. It displays the PdMA
logo, the name of the program, and the testing mode.

Asset Selected
This area displays the asset name that has been selected. It changes as different assets are
selected from the asset list. It will display “No Asset Selected” until one is selected.

Search
The Search text box, located below the Asset Selected area, allows you to enter the name
of an asset you are trying to locate in the database. Type the asset name in the box and
click the Search button

. If you search for partial names, it will find assets with

those characters in the name.

Left Panel
The left panel, shown in Figure 3-87, displays the WatchList imported from MCEGold,
which is shown in Figure 3 - 87. If there are no WatchList in MCEGold nothing will
display in this panel.

Figure 3-87: MCEGold WatchList

Center Panel
The center panel, shown in Figure 3-87, is blank until a list is selected from the left panel.
After a list is selected, the panel is populated with a round colored circle indicating the
condition code, Asset Name, Type, Last Condition Change, Criticality, and Location. You
may need to use the scroll bar located across the bottom to see all of the contents.
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Right Panel
The right panel, shown in Figure 3-87, displays the Nameplate information for the asset
selected in the center panel list. Above the Nameplate information is a colored bar
indicating the condition code for the asset.

Testing Buttons
Above the center panel are two testing buttons; MCE Auto and EMAX Auto, shown below.
Selecting an asset and clicking either button starts the appropriate testing. See page 3-49
for more information.

TOOLBAR
The Toolbar buttons located across the bottom of the window are designed to quickly
access common Lite functions with one click. The buttons are inactive unless an asset has
been selected from the list. This section provides a description of the buttons.
Home returns you to the Home screen. In some cases, depending on where you are in the
process, the return button

in the lower right is visible and may be used to go back one

or more steps.
MCE starts MCE testing. For information about using the MCE Test Selection window
and MCE testings see Chapter 5, MCE Testing.

EMAX starts EMAX testing. For more information about using the EMAX Test Selection
window and EMAX testing see Chapter 6, EMAX Current Analysis and Chapter 7, EMAX
Power Analysis.

Test History opens the Test History window of the selected asset. For a complete
discussion about the Test History window see page 3-39.

Message Center displays the messages for the selected asset. For a complete discussion
about using the Message Center see page 3-53.

Create Message opens the Compose Message window so that you may compose a
message to be stored in the Message Center. For a complete discussion about using the
Compose Message window see page 3-56.
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Fault Zone opens the optical view of the Fault Zone Analysis. For a complete discussion
about using the Fault Zone Analysis see page 3-52.

Scheduler opens the Created Schedules window which displays testing scheduled for the
asset selected.

Go Back displays when you are not on the Home screen. It is located in the same spot as
the Close button and is visible depending upon where you are in the program. It allows
you to return to the previous screen.

Close causes Lite to close/exit.

3-82

© 2016 PdMA Corporation

REV. 1-05/20

